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INTRODUCTION TO C-PEN
Congratulations - you have just bought a photographic
memory! C-Pen is a Mobile Information Collector that reads,
remembers, processes and transfers printed text to your Win-
dows-equipped PC and PDA products. C-Pen is in essence
an electronic highlighter that saves the text you are mark-
ing. Carry it with you wherever you go!

Make it a habit to take your portable text collector with
you, and you are always ready to read and save text from
books, papers, brochures or business cards. You can easily
record price-lists, timetables, wine tips or witty quotes. You
don’t have to tear out pages any more.

With the portable dictionary you can translate and look up
words immediately without carrying around a printed
dictionary!

Your saved text files can later be transferred to your PC. It is
also possible to use C-Pen to read text directly into a Win-
dows application in your PC.

C-Pen Models
In order to accommodate different needs, several C-Pen
models are available. They all have the basic features
C Read, C Write and Notes. Some models are equipped
with additional applications such as C Dictionary, C Cal-
endar, Storage and C Message. The set of applications
depends on the  model. On the following pages you will
find a short description of the different C-Pen models and
their applications. For more information on C-Pen, please
refer to our webpage: www.cpen.com.
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C-Pen 600C
C-Pen 600C combines the reading function with transla-
tion ability, making it the perfect companion when travel-
ling or studying.

C-Pen 600C includes:

• C Read • C Direct • C Address
• C Write • Notes • Info
• C Beam • C Dictionary • Storage

C-Pen 600C also offers communication by cable as well as
by IR.

It is powered by two alkaline AAA batteries (1.5 V type,
LR03). See further important instructions, Battery,  p.21.

C-Pen 600C has a Trigg button, that you press while read-
ing, and an ESC button. It is possible to exchange the func-
tions between these two buttons.

For more information on C-Pen 600C, please refer to our
webpage: www.cpen.com.
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C-Pen 800C
C-Pen 800C has several additional features which make it a
superior tool for use in your work and studies and when
travelling.

C-Pen 800C includes:

• C Read • C Direct • C Address
• C Write • Notes • Info
• C Beam • C Dictionary • Storage
• C Calendar • C Message

Communication is available by cable as well as by IR.

C-Pen 800C is powered by a rechargeable battery. The  charg-
ing adapter is included in the C-Pen package.

The cable is used for both communication and for charg-
ing.

When reading with a C-Pen 800C you normally use the
automatic trigger.  The ESC button can, if you wish, be
exchanged to a Trigg button, a manual trigger.

C-Pen 800C also has a time, a sound and an alarm function.

For more information on C-Pen 800C, please refer to our
webpage: www.cpen.com.
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Your Personal Digital Assistant
To see which of the below mentioned applications your
C-Pen model has, see C-Pen models, p. 6-7.

Powerful features
• C Read

Reads in text - the basic function of C-Pen. Move C-Pen
over the text, and the text will be captured by the pen,
where it can be saved as a file for later processing.

• C Write
Allows you to enter characters by writing with C-Pen as
if it were an ordinary pen. This is useful when editing
text, entering file names, looking up words in C Dictio-
nary or searching for a contact in C Address.

• C Address
Stores and looks up contact information such as ad-
dresses, phone numbers and e-mail addresses. C Address
can be synchronized with Microsoft® Outlook and sup-
ports the vCard standard.

• C Direct
Enables you to transfer the scanned text directly from
C-Pen into your PC. The text will be placed at the cursor
position in any Windows program.

• C Beam
Transfers notes, contacts, calendar events and files be-
tween C-Pen and PDAs. C Beam supports the standard
infrared protocol IrOBEX and complies with both the
vCard and vCalendar standards. All devices and appli-



9

cations using the IrOBEX protocol to its full extent are
fully compatible with C-Pen.

• C Calendar
Works like a normal calendar with the advantage of dis-
playing the information in many different ways once
you have the information in your C-Pen. You can choose
to view a whole month, a single week or a day and you
can either read or write event/task information into your
C-Pen.

• C Dictionary
Enables your C-Pen to translate and/or look up words.
C Dictionary is very easy to use, simply slide your C-
Pen over the word you require translated and within less
than a second the result is displayed. Several language
software packages are available.

• C Message
Sends text messages in combination with a mobile
phone. With C Fax you can send fax messages, while
C SMS is used when you want to send text messages,
SMS, to a mobile phone or an e-mail to an e-mail ac-
count. You can either send complete files from Notes or
write a short message with C Write into C Message and
then send it. C Message requires a mobile phone that is
equipped with an IR eye and a fax modem and that is
using the GSM system.

• Storage
Storage area in C-Pen, which can be used as a floppy
disc for files.
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Optimal Reading Conditions
C-Pen uses Optical Character Recognition (OCR) to read
text. OCR is the process of turning an image of characters
into computer-readable text.

As C-Pen moves over the text, its internal light source illu-
minates the characters and a camera takes pictures of the
text. During OCR, C-Pen analyzes the pictures taken by its
camera and translates them into text characters.

The OCR quality will depend on the reading conditions.
The letters most commonly confused using OCR are:

e → c l → I t → c

r+n → m i → l c → o

The following conditions affect the quality of character
recognition:

• The print quality of the text
High-quality printed text naturally gives maximum
OCR accuracy. With lower-quality print, e.g. faxes,
OCR accuracy may be poorer. You can calibrate the
C-Pen to optimize its performance under difficult
conditions; see Calibration, p. 91.

Please note that C-Pen only recognizes machine-printed
characters such as laser-printed or typewritten text.
C-Pen does not recognize handwritten text.

• Position and movement of C-Pen
It is important how you hold and move C-Pen over the
printed text. Please see Reading and saving text, p. 28
or read the Quick Start folder to learn how to use

!
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C-Pen correctly. It is crucial that you follow these
instructions in order to get the best results.

• The language of the text
Set the text language of the text you wish to read, to
get the most suitable OCR. See Text Language, p. 90.

• Deformed characters
Anything that is not a printed character, and any
character distorted by a mark or smudge on the paper
may be unrecognizable.

• Overlapping characters
Characters in the text should not overlap.

• Italics and underlined text
Italics are slightly difficult for C-Pen to read in some
fonts. Underlined text is also difficult for C-Pen to
read because the underline changes the shapes of the
descenders of the letters g, j, p, q and y.

• Text colors - text and surface
C-Pen cannot read some combinations of text colors
on colored surfaces, such as red or yellow text on a
white or red background.

Text that is highlighted by a traditional highlighter
marker can be read in some cases, depending on the
color and darkness of the ink.

• Small or large character sizes
The size of the characters should be 5–22 points.
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User Documentation and Support
There are several sources of support for your C-Pen.

This User's Guide contains a description of C-Pen, its ap-
plications and instructions for reading and editing text and
saving files. The following applications are explained:

• C Read • C Direct • Storage

• C Write • C Beam • C Dictionary

• Notes • Info • C Calendar

• C Address • Settings • C Message

You can also learn how to connect C-Pen to a PC.

The enclosed C-Pen CD contains the C-Win Software for
communication between C-Pen and your PC. It also con-
tains several help files:

• Help

• User's Guide in several different languages

• Troubleshooting, which helps you solve many
problems

On our web site, www.cpen.com, you can find Trouble-
shooting and the User’s Guide translated into several lan-
guages. Visit our web site, www.cpen.com, to get the latest
C-Pen news and free software upgrades.

Care and Safety
• Keep C-Pen away from direct sunlight, heat, moisture

and dust.

• Do not expose C-Pen to extreme temperature
variations.
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• Make sure the camera opening is free from dust or any
other objects.

• Do not deliberately insert any object into the camera
opening.

• Clean C-Pen with a dry cloth. Do not use detergents or
other chemicals when cleaning C-Pen.

• C-Pen models that are powered by alkaline batteries,
require two 1.5 V AAA batteries of type LR03.
Rechargeable C-Pen models have a built-in battery
which is to be recharged with C Technologies’
recharging adapter. See Battery, p. 21.

• Make backup copies of your C-Pen files regularly and
keep the copies in a safe place. Copies are made using
C-Win Software, see Using C-Pen with your PC,
p. 106.



14

PRESENTATION OF C-PEN

Parts of C-Pen
There are some differences between the C-Pen models. The
main differences concern the battery, the ESC button and
the Trigg button. There is no battery compartment in a
rechargeable C-Pen, since the battery is built-in. On a
C-Pen that has an automatic trigger, an Autotrigger, the
button on the front of the pen is the ESC button, while on
the other models this is the Trigg button. For more infor-
mation about your C-Pen model see C-Pen models, p. 6-7,
Technical Specifications, p. 115 and the following pages.

Description of the different parts:

C-Pen with a manual trigger

1

2

4

5

5
3

9

10

3

10
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C-Pen powered by AAA batteries

1

C-Pen with an automatic trigger

4

Rechargeable C-Pen

1

1

7

2
10

6

9

4

3

11

8
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1. On/Off and Nav
Turns C-Pen on or off when pressed and held for more
than two seconds. This button is also used to scroll
through the menus and texts (push up or down) and to
select an item or an option (press briefly).

2. ESC
Closes menus. Please note that this is the button on the
top of a C-Pen with an automatic trigger, while it is, as
default, the button on the side of C-Pen with a manual
trigger.

3. Display
Used to display scanned text and for communication
between C-Pen and the user. The orientation of the text
on the display can be changed to suit left-handed users.
See System Settings, p. 94.

4. IR port
The infrared (IR) port is used for wireless data transfer
between C-Pen and a PC, mobile phone or PDA  that is
equipped with an IR port.

5. Trigg
On a C-Pen with a manual trigger, Trigg is to be pressed
and held down while reading text. The functions of Trigg
and ESC can be exchanged to suit your own prefer-
ences. See System Settings, p. 94. Some C-Pen  models
have an automatic trigger, Autotrigger, see figure p. 15.

6. Autotrigger
For a C-Pen with an automatic trigger, the Autotrigger
is located at the rim of the camera opening. When read-
ing correctly, the Autotrigger is pressed into the pen.
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7. Cable Socket
The Cable Socket is where you plug in the cable that
connects C-Pen to your PC. The cable is used to com-
municate and transfer files to and from C-Pen to
your PC.

8. Cable and Charging Socket
For the rechargeable C-Pen the same cable is used for
both communication and for charging. Insert the plug
into this socket in order to recharge the battery and to
communicate with your PC.

9. Battery Compartment
For a C-Pen that is powered with AAA batteries, this is
where you insert the batteries.

10. Camera Opening
The Camera Opening is not protected in any way.
This enhances C-Pen’s reading ability but it also
makes it important to see to that dust or other objects
do not enter the camera opening.

11. Reset Button Hole
For a rechargeable C-Pen, if the pen seems to have
“frozen” gently insert something similar to an unfolded
paperclip into the Reset Button Hole and press. This
will reset C-Pen.

For C-Pens that are powered by AAA batteries, the way
to reset the pen is simply to remove the batteries from
the battery compartment, and then replace them.
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Display Objects
C-Pen uses the following display objects to communicate
with you:

• status field

• application icons

• menus

• check boxes

• dialog boxes

• edit fields

• dialog buttons

Status field
The area on the left side of the display is called the status
field. This field can display the time, current application,
text settings (Text Quality and Text Language) and
C-Pen’s battery power level. See also Settings, p. 89 and
Battery, p. 21.

The information displayed in the status field differs de-
pending on the C-Pen model.

Application icons
The applications are represented by application icons on
the main screen. The applications are described in the chap-
ter Applications, p. 46.

Text Language

Text Quality

Battery power level

TimeAlarm icon

Application icon
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Menus
Menus provide different options. A scroll bar indicates if
there are more menu items available above or below the
visible section.

Check boxes
Check boxes also provide different options. A check box
remains checked until you uncheck it or check another of
the alternative boxes in the list.

Menu items

Menu

Scroll bar

Checked box
Unchecked box

C-Pen main screen
Application icons
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Dialog boxes

A dialog box appears when you need to enter information
or give commands to C-Pen. A dialog box contains one or
more objects such as edit fields or dialog buttons.

Edit fields
It is possible to enter and edit text in an edit field. An edit
field is recognized by its frame, see the figure above.

Dialog buttons
Dialog buttons are used in dialog boxes to give simple
instructions to C-Pen.

Common dialog buttons

Edit field

Dialog box
Dialog buttons
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GETTING STARTED

Turning C-Pen On and Off
To turn C-Pen on and off, press the On/Off button until the
display is activated/deactivated. C-Pen turns off automati-
cally after 5 minutes of  inactivity. To change the auto-
matic power-off time, see System Settings, p. 94.

Battery

C-Pens powered by AAA batteries

Installing the batteries
1. Remove the battery cover from the back of C-Pen.

  

Press Nav to turn C-Pen on and off

Lift the cover here to open



22

It is imperative to observe the polarity of the batteries.
The orientation of the plus and minus ends is shown
inside the battery compartment.

2. Insert two alkaline AAA batteries (1.5 V, type LR03).

3. Replace the battery cover. You should hear a “click”
when it locks in place.

Please do not dispose of batteries in a fire as there is a
danger of explosion. Please recycle the batteries!

Battery power level
The battery power level is shown by the battery indicator
at the bottom of the status field.

If the battery power level is getting low, the message “Bat-
tery low” will appear on the display. To avoid losing un-
saved information, save all material not previously saved
and then change the batteries. Turn C-Pen off before chang-
ing batteries. To change batteries, see Installing the bat-
teries p. 21.

!

Text LanguageBattery power level

Text Quality

!
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If the battery power level is so low that the pen can no
longer function, you will get the message “Battery level
too low! Shutting down.” You must change the batteries to
be able to continue using C-Pen.

Please note that information may be lost if you remove the
batteries without turning C-Pen off first. However, when
you turn C-Pen off properly, all information is saved in
the memory and it is safe to remove the batteries.

C-Pens that are powered by alkaline batteries are reset by
removing the batteries from the battery compartment. Do
this when C-Pen has encountered problems or has “fro-
zen”.

Rechargeable C-Pens

Battery power level
The battery power level is shown by the battery indicator
at the bottom of the status field.

If the battery power level is getting low, the message
“Battery level low” will appear on the display. You should
recharge the battery to ensure that information which has
not previously been saved will not be lost.

In order to recharge the battery, insert the charging adapter’s
plug into the C-Pen charging socket. The charging adapter
is included in the C-Pen package. It is possible to recharge

!

Text Language

Text Quality

Battery power level

TimeAlarm icon

Application icon
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the C-Pen both when it is turned on and when it is turned
off. While recharging, the battery power level icon indi-
cates this by moving back and forth in the status field.

Charging is completed when the battery power level icon
stays steady. Charging normally takes about 1.5 h.

Please note that C-Pen will recharge only if the room
temperature is between +5 and +45ºC (+41 and +113ºF).
For temperatures above +35ºC (+95ºF) the recharging
process will take a little longer (1.5 - 2.5 h). For tempera-
tures below +5ºC (+41ºF) the recharging process will
cease, but will continue if the temperature rises above
+5ºC (+41ºF).

When the battery is not charging the indicator is station-
ary.

If recharging does not start
If the charger is connected to C-Pen and the recharging
process does not start, follow these instructions.

1. Disconnect the charger from your  C-Pen.

2. Insert something thin (like an unfolded paperclip) into
the reset hole and press gently, see figure on p. 15.

3. Reconnect the charger to C-Pen.

4. C-Pen should begin recharging the battery within 10
seconds. If recharging does not start (the battery power
level icon is not moving in the status field) please
repeat steps 1-3 above. Remember to make sure that
the charger is not connected to C-Pen while pressing
the reset button.

!
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If C-Pen has encountered problems or has “frozen”, insert
something thin (like an unfolded paperclip) into the reset
hole and press gently, see p. 15.

Navigating and Selecting
Nav (the navigation control) is used for navigation and to
select an object.

Turn Nav up or down to navigate between

• menu items

• dialog buttons

• edit fields

• check boxes

• lines or characters in text

As you move between objects, they become highlighted
(inverted).

Pressing Nav briefly when an object is highlighted is re-
ferred to as selecting that object.

The result when selecting an object is explained for each
situation later in this manual. Below are some general re-
marks about selecting objects.

Turn to navigate between fields

Press to select an object
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Menus
Selecting a menu item marked with a  will display
further alternatives in a new menu.

Selecting EXIT or CANCEL will close the menu. Instead of
selecting EXIT or CANCEL, you can press ESC.

 

Dialog buttons
In a dialog box you can instruct C-Pen how to continue by
selecting a dialog button:

• OK

You accept a suggestion in a dialog box.

• YES

Your answer is “Yes” to a question in a dialog box.

• NO

Your answer is “No” to a question in a dialog box.

• CANCEL

The dialog box is closed and you return to your earlier
menu or screen. Instead of selecting CANCEL, you can
press ESC.

Edit fields
To be able to edit text in an edit field, you must first select
the field.

Menu item with
alternatives
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A cursor will appear in the edit field and the status field
will show the edit mode symbol. See Editing text, p. 33.

 

Check boxes
To mark an alternative in a list of check boxes, navigate to
the alternative of your choice (using the Nav button).

 

Mark the alternative by selecting it (press the Nav button
briefly).

 

The check box becomes checked and the OK button is
highlighted. Press OK if you are satisfied with your choice,
otherwise press CANCEL.

Edit field

Cursor

Edit mode symbol
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READING AND SAVING TEXT
Please follow the instructions in this chapter in order to get
the best results from your C-Pen. Take a few minutes to
learn how to use C-Pen correctly. See also Optimal Read-
ing Conditions p. 10.

In this User's Guide “read text” should be interpreted as
reading a line of text, not a line on C-Pen’s display.

Reading Text

C-Pen with a manual trigger
To read a line, follow the steps below.

1. Turn C-Pen on. Make sure the text settings are set to
the appropriate values. The text settings are Text
Language, Read Mode and Text Quality. It is also
possible to calibrate C-Pen for best performance. See
Settings, p. 89.

2. Place C-Pen over the first character you want to read.
Hold C-Pen with the pen tip flat against the surface.
Make sure that the camera opening covers the entire
height of the line. C-Pen reads one line at a time.

3. Press and hold Trigg.
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Please note that the text surface must be completely flat in
order to achieve maximum reading accuracy.

4. Move C-Pen over the line of text, keeping Trigg
pressed. You can move C-Pen left-to-right or right-to-
left over the text. You can read up to 15 cm/second
(6 inches/second).

5. Release Trigg at the end of the line.

!
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C-Pen with an automatic trigger
This C-Pen model has an Autotrigger in order to facilitate
the reading process. To read a line, follow the steps below.

1. Turn on C-Pen. Make sure that the text settings are set
to the appropriate values. The text settings are Text
Language, Read Mode and Text Quality. It is also
possible to calibrate C-Pen for best performance. Refer
to Settings, p. 89.

2. Place C-Pen over the first character you want to read.
Hold C-Pen with the pen tip flat against the surface.
Aim at the center of the line. C-Pen reads one line at a
time.

Please note that the text surface must be completely flat
in order to achieve maximum reading accuracy.

3. Move C-Pen over the line of text. Keep the pen tip flat
against the surface while reading. Make sure the
Autotrigger (at the pen tip) is pressed. You can move
C-Pen left-to-right or right-to-left over the text. You can
read up to 15 cm/second (5 inches/second).

!
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4. Lift the pen at the end of the line in order to release
the pen’s Autotrigger.

Continued reading
The Text screen will appear on the display.

 

The text is placed in a new text file in Notes, see p. 48. You
can also create a new, empty text file by selecting New...
and then FILE in Notes, before you start reading.

Reading another line
Read the second line in the same way as you read the first.
A space, a line break or a tab is inserted between the lines,
see Read Mode, p. 89. You can insert a line break by press-
ing Trigg (C-Pen with a manual trigger) or Autotrigger
(C-Pen with an automatic trigger).

The last line is highlighted (negative), i.e. light text on a
dark background. To delete the last line, press ESC briefly.

Text screen
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Deleting a line
To delete any of the lines you have read, proceed as
follows.

1. Move the cursor (the flashing triangle) with the Nav
button to the beginning of the line. Press Nav and the
Text menu opens, see p. 50.

2. Scroll through the menu items until you find Select
and press Nav. The line becomes highlighted.

3. Press ESC briefly. The line disappears and you are
ready to read a new line.

 

Saving Text
Press Nav to open the Text menu (see Notes, p. 48) and
choose Exit. The Save As dialog box appears. Choose YES
if you want to save the text, NO if you want to discard the
text or CANCEL if you want to return to the text. The dialog
box contains an edit field with a suggested file name. You
can change the file name before you save the file; see
Editing text in the next section.
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EDITING TEXT
To be able to edit text in a text file or in an edit field you
must enter edit mode.

Entering Edit Mode
You can enter edit mode in different ways depending on
your starting-point. You can enter edit mode from the Text
screen or from an edit field.

Entering edit mode from the Text screen
Press Nav in the Text screen to open the Text menu. Select
Edit/C Write to enter edit mode. You can now edit text
either by using the Edit menu (see below) or by using
C Write (see p. 38).

Entering edit mode in an edit field
Press Nav when the edit field is highlighted to enter edit
mode. You can now edit text either by using the Edit menu
(see below) or by using C Write (see p. 38).

Edit Menu
When you are in edit mode a cursor appears and the edit
mode symbol is shown in the status field.

 

CursorEdit mode symbol
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In edit mode you can move the cursor one character at a
time by turning Nav. You can move to the beginning or the
end of the text with the Go to option in the Edit menu.
Move the cursor to the position where you want to edit the
text. Press Nav to open the Edit menu.

The options in the Edit menu are slightly different, de-
pending on whether you want to edit a field in C Address
or a text in Notes. The most common items in the Edit
menu are:

• Quit Editing
Exits edit mode in the Text screen.

• Done
Returns to the text from the edit mode in an edit field.

• Change
Changes the character to the right of the cursor.

• Insert
Inserts new characters, a space or a line break at the
cursor’s position.

• Cut
Cuts out the selected characters.

• Copy
Copies the selected characters.

Edit menu
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• Paste
Pastes a cut out or copied selection of characters.

• Delete
Deletes a character or a selection of characters.

• Go to
Moves the cursor to the beginning or the end of the text.

• Select
Highlights characters or an entire text.

• Settings
Sets the text settings (Text Language, Text Quality and
Read Mode) of the text you are reading. The options
Calibration and C Write Feedback are also included
here.

• Cancel
Closes the edit menu. Returns to the read text.

The menu items are explained in greater detail below.

Change
Place the cursor to the left of the character you want to
change and select Change from the menu. Turn Nav to
select the new character from the character set and then
press Nav.

 

The character set
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As default C Write Prototype Viewing is enabled. When
scrolling in the character set you can see how the charac-
ters should be drawn if you want to use C-Pen as a normal
pen during editing. C Write Prototype Viewing is auto-
matically turned on/off when C Write Feedback is  turned
on/off, see  p. 39.

Insert
Move the cursor to the place where you want to insert text,
and select Insert from the menu. You can choose between
inserting a space, a line break, a character or multiple char-
acters.

Select Character in the insert menu to insert one charac-
ter. Then turn Nav to select a character from the character
set and press Nav. The character set closes automatically
after insertion.

To insert more than one character, select Multiple Charac-
ters. Turn Nav to select a character from the character set
and press Nav. The character set remains on the display
and you can continue inserting characters.

As default C Write Prototype Viewing is enabled. When
scrolling in the character set you can see how the charac-
ters should be drawn if you want to use C-Pen as a normal
pen during editing. C Write Prototype Viewing is auto-
matically turned on/off when C Write Feedback is  turned
on/off, see  p. 39.

When you are finished, press ESC or the DONE button (in
the end of the character set) to return to the text you are
editing.
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Select
Use the Select command to edit more than one character at
a time. Then select Characters and turn Nav to mark mul-
tiple characters. Press Nav and choose Cut, Copy or Delete
from the menu. If you select All, the entire text will be se-
lected.

Cut, Copy and Paste
To be able to choose Cut, Copy or Paste you must have
selected part of a text. If you have chosen Cut or Copy you
can Paste the text section at the cursor’s position by press-
ing Nav and selecting Paste in the menu.

Delete
Place the cursor to the left of the character you want to
delete and select Delete from the menu. If you have se-
lected several words or lines, the whole selection will be
deleted, see Select above.

Settings
Detailed explanations of the settings are to be found in
Settings, p. 89. The available settings are:

• C Write Feedback
Mark/unmark the check box to switch the C Write
visual feedback on/off. See p. 39.

• Text Language
Select the language of the text you are reading.

• Read Mode
Select Continuous or Separate lines.
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• Text Quality
Select Normal or Inverted.

• Calibration
You can either calibrate C-Pen or revert to the default
setting.

Quit Editing
Quit edit mode by selecting Quit Editing.

C Write
C Write is a feature that allows you to draw characters by
using C-Pen as an ordinary pen. C-Pen can track its own
movement over a surface and recognize the movement as a
letter, digit or a symbol. C Write is an alternative to using
the character set when inserting characters in a text.

Please note that to be able to use C Write, the surface
you “write” on must have a distinct pattern. Printed text
is the best choice.

Use C Write in the following way:

1. Enter edit mode.

2. Position the cursor on C-Pen’s display.

3. Place C-Pen with the pen tip flat against a text surface.

4. Form a letter, see C Write Prototypes, p. 42. When using
a C-Pen with a manual trigger, the Trigg button must be
pressed while forming the letter.

5. Lift the pen from the surface. When the pen is lifted from
the surface an image will briefly appear on the display,
showing the letter as perceived by your C-Pen.

!
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You do not have to wait for this image to disappear
to write your next letter.  The function is called
C Write Feedback, and is enabled as default.

The C Write Feedback utility can be switched on/off as
follows.

1. Go to Settings in the main screen.

2. Select C Write Feedback.

3. Uncheck/check the check box according to your per-
sonal preference.

4. Select OK.

Basic rules when using C Write
It is important that the pen tip is in contact with the surface
while you are writing. For a C-Pen with a manual trigger
Trigg must be pressed before you start writing.

The writing surface must have a distinct pattern, such as a
printed text. Solid colors or simple repetitive patterns (lines,
squares, grids) should be avoided.

Visual feedback
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In order to obtain maximum accuracy when writing with
C-Pen, your characters should resemble the prototypes on
the following pages as closely as possible.

A character must be drawn in one single stroke. The dot
indicates the starting point of the stroke, see next page.

The height of the character should be 1 - 4 cm
(¼ - 1¼ inch).

Capital letters
When you enter edit mode the status field will
change appearance. The edit mode symbol indi-
cates that C Write will generate lowercase
letters.

To write a capital letter, you have to write the shift
sign first, see C Write Prototypes. Only the first
letter will be a capital. The status field will reflect
this choice.

If you write two shift signs, C Write will enter
Caps Lock mode. All letters will be capitals until
you write a shift sign again.

Symbols
When using a C-Pen with a manual trigger, press Trigg
briefly to enter symbol mode.

C Write Capital letter icon

C Write Lowercase icon

C Write Caps  Lock mode icon
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When using a C-Pen with an automatic trigger, press the
pen tip briefly against the surface to enter symbol mode.
The Autotrigger at the rim of the pen must be pressed into
the pen.

The status field displays the Symbol mode icon.
Write one of the symbols in the symbol table.
After writing a symbol, C-Pen automatically
returns to normal mode.

If you want to quit symbol mode without writing a symbol,
you have to draw a backspace symbol.

C Write symbol mode icon
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C Write Prototypes
Letters, digits and shift

Shift Space Backspace New line

Aa Bb Cc Dd Ee

Ff Gg Hh Ii Jj

Kk Ll Mm Nn Oo
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Pp Qq Rr Ss Tt

Uu Vv XxWw Yy

Zz

1 2 3 4 5

6 7 8 9 0
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. , : ; / \

Special characters

Çç Ææ Øø

Accents and umlauts

Write the letter first and then the accent or umlaut.

Example: ä=a+

¨ º ^ ´ ` ~

Symbols

Enter symbol mode by pressing Trigg or the Autotrigger
briefly.
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( ) [ ] { }

- + * $ @ “

# _ < > ? ¿

! ¡ £ § ß %
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APPLICATIONS
C-Pen’s application icons are shown on the main screen.
You can move between the icons by using Nav. Press Nav
to start an application.

To see which of the below mentioned applications that
comes with your C-Pen, see C-Pen models, p. 6-7.

 

Notes contains your read and stored text files.
See p. 48.

C Address is an address book, where you can
store business cards and search for contact in-
formation. C Address can be synchronized with
Microsoft® Outlook on a PC, and with PDA
devices, see C Beam, p. 52 and 113.

C Calendar works like a normal calendar with
the advantage of displaying the information
in many different ways once you have the in-
formation in your C-Pen. See p. 58.

C Dictionary can read and translate words be-
tween the languages you have chosen for your
C-Pen. See p. 72.

C Message is used to send SMS, e-mail and
fax messages in combination with a mobile
phone. See p. 81.

C-Pen main screen
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Settings contains parameters which can be
changed such as power-off time and reading
options. See p. 89.

Info contains information about your C-Pen’s
serial number, OS (Operating System) version,
free memory space, etc. See p. 97.

Storage can store files for transfer between
computers. See p. 98.

C Direct contains information on how to trans-
fer text from C-Pen directly into a Windows
program. See p. 103 and 114.

C Beam is used to transfer notes, contacts, cal-
endar events and files between C-Pen and
PDAs (Personal Digital Assistant). C Beam sup-
ports the standard infrared protocol IrOBEX
and complies with both the vCard and
vCalendar standards. See p. 100.

C Write contains information about and ex-
amples of how to write letters with C-Pen. See
p. 38 and 105.
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Notes
Notes contains the text files you have read and saved. Enter
Notes by selecting the Notes icon on the main screen.

 

Inside Notes, move between items using Nav.

You can transfer files from Notes in C-Pen to your PC. To
do this, C Win Software must be installed on your PC. See
Using C-Pen with your PC, p. 106.

Creating a new file or folder
Selecting New... will open a dialog box. Select FILE to
create a new file.

 

Please note that if you are in the main screen or in Notes
you do not have to execute this command to create a new
file. A new file will automatically be created when you
start to read with C-Pen (except when you are already in
the Text screen). New text files will be placed in Notes.

Select FOLDER to create a new folder. A dialog box ap-
pears. Select the edit field to give the folder a name.  Use
C-Pen to read a name or press Nav to enter edit mode and

Your list of text
files starts here

!
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then write a name with C Write. To save the folder, select
OK. The folder will be placed in Notes.

 

If you want to save a file in a specific folder, you must
create the file in that folder. Open the folder, select New...
and then select FILE in the dialog box.

The Command menu
The Command menu contains commands for handling
texts. Open the menu by selecting a text file and pressing
Nav.

 

The options in the Command menu are:

• Open
Opens the selected file.

• Rename
Renames the selected file. A dialog box with an edit
field appears.

• Delete
Removes the selected file.

Command menu
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• Properties
Displays the file size, and if applicable the creation
date and the date of last modification of the selected
file.

• Send 
Only applicable if C Message is available. Opens a
new menu in which,  you can choose to send the file as
SMS, SMS-Email or as a fax message.

• Beam
Transfers the selected file by IR, see p. 100.

• Cancel
Closes the Command menu.

The Text menu
In the Text screen you can move the cursor line by line
with Nav. You can insert a new line at the cursor position
(the flashing triangle) by reading a new line with C-Pen.

 

Press Nav if you want to edit the text,  go to the beginning
or end of the text, change text settings or stop working with
the text. Pressing Nav opens the Text menu.

Text menu
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The items in the Text menu are:

• Exit
Closes the text. If the text has been changed you are
prompted to save it before it is closed.

Select SAVE AS... if you want to save the changed file
with a new name.

• Edit/C Write
Enters edit mode. See p. 33.

• Settings 

Opens the text settings of the text you are reading. See
Settings, p. 89.

• Select
Highlights a read line/word.

• Go to 

Moves the cursor to the beginning or the end of the
text.

• Cancel
Closes the Text menu.
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C Address
C Address is an application in C-Pen for storing and look-
ing up contact information such as the addresses, phone
numbers and e-mail addresses of people and organizations
you communicate with.

The number of addresses that a C-Pen can store is 1000.
When the number of contacts exceeds 50 they will auto-
matically be divided into folders.

Start C Address by selecting the C Address icon on the
main screen.

 

The C Address main screen will open:

 

Below the menu items Exit, New... and Find, your contacts
are listed.

Enter a new contact
To enter a new contact, select New... in C Address main
screen. The Contact edit screen will open.

In the Contact edit screen, turn Nav to go to the first field,
called First name. Read the first name of your contact with
your C-Pen, for instance from a business card or a tele-

C Address
main screen

Contact list

C-Pen
main screen



53

phone list, turn Nav to move to the next field, Last Name.
Continue reading text into the following fields in the same
way.

 

You can always move to any field you want by turning
Nav. If you want to change a field that you have entered,
just go to the field that you want to change and read again.
Enter edit mode if you want to edit the contents of the field,
see p. 33.

You can change the choice of contact details (addresses,
phone numbers, e-mail addresses etc.) in OPTIONS. Select
OPTIONS and scroll through the options. Check or uncheck
the boxes according to your personal preferences. When
you are finished, select OK or just press ESC.

 

You can discard the information you have entered in a
contact file by selecting CANCEL. If you want to discard all
changes select YES when a dialog box appears.

Selecting TOP at the end of the field list brings you to
SAVE. If you choose SAVE, the changes will be saved and
then the Contact edit screen automatically closes.

Contact edit
screen

Check boxes
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Select SAVE when you are finished. The Save as dialog box
appears. The suggested file name is the name you entered
in the Full name field. If this field is empty or unchecked
the suggested file name will be “Last name, First Name”.
You can edit the file name or you can read a new file name
with your C-Pen.

A file name must not be longer than 64 characters. Invalid
characters like ‘\’ or ‘.’ will be replaced with a blank space.
If the file name already exists, a number suffix will be added
to the file name, i.e. ‘John Mills (2)’ if ‘John Mills’ already
exists.

Select YES to save the contact file. A new contact is added
to your contact list.

The contact menu
The Contact menu contains options for working with con-
tact files. Open the menu by selecting a contact in the con-
tact list.

 

The options in the Contact menu are:

• View
Lets you view the information you have entered on a
contact.

Contact menu
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• Edit
Lets you edit the information you have entered on a
contact.

• Delete
Deletes the contact file.

• Rename
Renames the contact file.

• Beam
Transfers the selected contact file by IR, see p. 100.

• Top (Exit)
Brings you to the top of the C Address main screen.

• Cancel
Closes the Contact menu.

View a contact
Select View to look at a contact. The contact information is
presented in the Contact view. Turn Nav to scroll through
all contact information.

 

Press Nav or ESC to exit the Contact view and return to the
C Address main screen.

Contact view

Blinking when
activated
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Edit a contact
You can edit a contact by selecting it in the contact list and
then select Edit in the Contact menu.

This will open the Contact edit screen, displaying all the
stored information. You can move between fields by turn-
ing Nav. If you want to change the contents of a field, you
can read a new field text with C-Pen or edit the text in the
usual way, see Editing text, p. 33.

Find a contact
To find a contact, navigate to the C Address main screen
and select Find. The Find contact screen will open.

 

Enter the search text either by using C Write, or insert
characters from the character set. To start searching
C Address, select the FIND button. The Find contact screen
closes and a contact list containing the contacts with match-
ing information will be displayed. You can select these
files, just as you do in the contact list.

If the Search all fields check box is checked, all information
stored in C Address will be searched in order to find matching
text.

If the Search all fields check box is not checked only
names will be searched, (First name, Last name and
Full name).

Find
contact screen

!
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Select DONE to close the screen and return to the
C Address main screen.

If no matching text is found, a dialog box with the message
“Nothing found” appears. Select OK to go back to the Find
contact screen.

Delete a contact
Select a contact in the contact list and select Delete.
A dialog box will ask you if you are sure that you want to
delete the contact. Select YES. The contact is now deleted.

Exit C Address
You can exit C Address from the C Address main screen
by selecting Exit or by pressing ESC.

Search result
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C Calendar

Introduction
C Calendar is an application which works like a normal
calendar, but with the advantage that you can display your
events and tasks in many different ways once you have the
information in your C-Pen. You can choose to view a whole
month, a single week or a day, and you can either read or
write the information into your C-Pen.

Using C Calendar
Start C Calendar by highlighting the C Calendar icon in
the C-Pen main screen and pressing Nav.

 

The information is displayed in the Day view, Week view,
Month  view or the Task list, see p. 66. You can choose to
change to another view or you can either look at or edit the
stored events/tasks. You change view with the View but-
tons, see below.

View buttons
On the left-hand side of the bottom line of the display are
three buttons. The buttons change depending on where
you are in C Calendar and they change between the fol-
lowing four alternatives:

C-Pen
main screen
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• Day button
The button with number 1 in the display. When the
Day button is pressed the Day view appears, see p. 62.

• Week button
The button with number 7 in the display. When the
Week button is pressed the Week view appears,
see p. 62.

• Month button
The button with number 31 in the display. When the
Month button is pressed the Month view appears, see
p. 63.

• Task button
The button with a check mark in the display. When
the Task button is pressed the Task list, see p. 67, is
opened.

 

When a view has been chosen the cursor automatically
highlights the Menu button.

 

Menu button
Selecting the Menu button opens the C Calendar main
menu.

In the menu you can choose between the alternatives listed
below. Please note that the alternatives New..., Select…
and Go to month/week/date depend on whether you are in
the Task list, day, week or month view, see below.

Menu button

Day, week, month and task button
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In C Calendar you will always find the scroll bar on the
right-hand side of the display.

Pressing the Menu button opens the C Calendar main
menu with the following alternatives:

• Exit
Closes C Calendar and returns to the C-Pen main screen.

• New…
Opens a new event/task in the Event edit screen/Task
edit screen.

• Select week
Enables the selection of a whole week at a time in the
Month view. When a week is highlighted and Nav is
pressed, the chosen week’s Week view will be displayed.

• Select day
Enables selection of a day in the current Week view.
When a day is highlighted and Nav is pressed, the
selected day is opened in the Day view.

• Select event
Enables selection of one of the listed events in the cur-
rent Day view. When an event is highlighted and Nav is
pressed, all the event details are displayed. See the
Details screen, p. 68.

C Calendar
main menu

!
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• Select task
Enables selection of one task in the currently displayed
Task list. When a task is highlighted and Nav is pressed,
all the task details are displayed. See the Details
screen, p. 68.

• Find…
Opens the Find dialog box. See Finding an event, p. 69.

• Go to date/week/month...
Opens a dialog box in which you can enter a particular
month, week or date. As default the present month/week/
date is selected.

• Settings…
Shows the settings and enables you to edit them.

• Cancel
Closes the C Calendar main menu.

Back/Forward button
On the right-hand side of the bottom line of the display are
two arrow buttons which are called the Back/Forward but-
tons.

The right-arrow button is the Forward button and changes
the date forwards in time, while the left-arrow button, the
Back button, changes the date backwards.

If you want to change a date a long time ahead of the present
date you can press the Menu button and then select the
option Go to day/week/month… in the C Calendar Main
menu, p. 60

Forward buttonBack button
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Day view
The Day view is reached by clicking the Day button, see
p. 59, on the bottom line of the display.

When you are in the Day view another day can be viewed
by clicking the Back/Forward buttons on the bottom line,
see above.

 

The Day view is used to view all events during one par-
ticular day and the title of the event is given to the right of
the starting time. Depending on the chosen event alterna-
tives (repetition, note and alarm), different icons will be
shown to the right of the event title.

Brackets are used to show the event’s length and possible
overlap with other events.

Week view
The Week view displays a single week at a time and the
screen is reached by selecting the Week button, see p. 62,
on the bottom line of the display.

 

Another week can be viewed by clicking the Back/For-
ward buttons on the bottom line, see p. 61.

Day view

Week view
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The Week view is used to view all events during one par-
ticular week and the events are shown as shaded boxes.
The size of the box corresponds to the length of the event
and the position corresponds to the starting time.

If the current date is in the chosen week, it is marked with a
circle around the date, see the figure above.

Month view
The Month view displays a single month at a time. The
screen is reached by selecting the Month button on the
bottom line of the display, see p. 59.

 

The previous/next months can be viewed by clicking the
Back/Forward buttons on the bottom line, see p. 61.

The Month view is used to view all events during a month
and the events are shown as small boxes to the right of the
date. The size of the boxes corresponds to the length of the
event and the position corresponds to the starting time.

When viewing the current month the current date is high-
lighted, see the figure above.

Creating an event
A new event can be created in two different ways: press the
Menu button, see p. 59, when you are in the Day, Week or
Month view and select New…, then read text directly with
C-Pen or enter edit mode and write the text into the edit

Month view
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fields with C Write. You can also read directly with C-Pen
when you are in a Day, Week or Month view. The scanned
text will automatically be placed in the title edit field of a new
event in the Event edit screen, see below.

Event edit screen
The Event edit screen is opened by pressing the Menu
button when you are in the Day, Week or Month view and
then selecting New…. It can also be opened from the
Details screen, see p. 68, by selecting Edit…. In both cases
you can edit all fields on the screen.

 

You can either read an event title directly into the first edit
field, Title, or you can enter edit mode by pressing Nav and
then use C Write. The same goes for the edit field called
Note in which you can enter the event details.

The next option is reached by turning Nav.

The time and date are changed by highlighting the first set
of figures (in Date this will be the year), then pressing Nav
and turning it to the required value. When you are done,
press Nav and you will automatically enter the next set of
figures (in Date this will be the number of the month) where
you can turn Nav to change the value. The check boxes are
checked/unchecked by pressing Nav.

If a repeating event is shown in the Details screen and you
press the Menu button and select Edit…, two optional check

Event edit
screen
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boxes are displayed. You can choose to edit the event only
for the current day or for an interval between dates. If an
interval is chosen, default is set to the full interval, but can
be changed if you want to. Clicking OK will open the cho-
sen event for editing.

To save your changes, click OK. Click CANCEL to discard
all changes. After clicking OK/CANCEL C-Pen automati-
cally returns to the previous screen. For further information
about the event options and the Repeat button see Event
options below.

Event options
The Event edit screen, see p. 64,  contains the following
options:

• Title
Event title. You can either read directly into the edit
field or enter C Write and write the text. Maximum length
of the text string is 60 characters.

• Time
Starting and finishing time in hours and minutes. As
default the starting time is set to at least one hour from
the present.

• Date
Starting date of the event. Year, month and day can be
set. As default the last viewed date in the Day View is set
as the starting date.
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• Alarm
Check/uncheck an audio reminder of an event. The time
can be set up to one hour before the event. The alarm is
independent of whether or not C-Pen is turned on or off.

Please note that the alarm check box is only available if the
starting time is ahead of the present date and time.

• Note
Further notes concerning an event can be placed in this
field, either by reading text or by entering C Write and
writing the text.

• Repeat
Events can be set to be repeated at certain intervals, see
Repeat check boxes below. Pressing the Repeat button
opens a dialog box in which you can set the interval of
repetition as well as the finishing date.

 

The Repeat check boxes are:

• Day
Every day

• Week
The same day every week

• Month
The same date every month

Repeat dialog box

!
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• Year
The same date every year

Creating a task
A new task can be created in two different ways: press the
Menu Button, see p. 59 when you are in the Task list, see
below, and select New…, then read text directly with C-
Pen or enter edit mode and write the text into the edit fields
with C Write. You can also read directly with C-Pen when
you are in the Task list. The scanned text will automati-
cally be placed in the title field of a new event in the Task
edit screen, see below.

Task list
When the Task view button is pressed the Task list is
opened and all the tasks in the calendar are displayed in
the order in which they were entered in C Calendar.

 

The tasks are shown with their title and their status, i.e.
checked or unchecked. The Attachment icon is shown be-
side a task if there are further notes belonging to the task.
Tasks are checked/unchecked in the Details screen, see
p.68.

Task list

Attachment icon
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Task edit screen
The Task edit screen is opened from the Task list in two
different ways: press the Menu button and select the op-
tion Select task in the menu. Press Nav when the required
task is highlighted and the Task edit screen opens. You
can also start reading text when you are in the Task list.
This will open the Task edit screen and the scanned text
will be placed in the first edit field (Title).

 

Pressing OK will save the task and the updated Task list
will then automatically be displayed. Pressing Cancel will
discard all changes made to the event.

Details screen
The Details screen can be opened both for events and for
tasks. Press the Menu button in the Day view and choose
Select event, then highlight an event and press Nav to
open the Details screen for an event.

If you want to view the details of a task, press the Menu
button when you are in the Task list and choose Select
task. Then highlight a task and press Nav to open the
Details screen for a task.

All information on the selected event/task will be displayed
on the screen.

Task edit screen

Task title

Cursor

Task notes
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When pressing Nav a menu appears with the alternatives
Done, Check, Edit..., Delete... and Cancel. Pressing
Cancel will take you to the previous screen.

A task can be checked/unchecked in the Details screen by
pressing Nav and then selecting Check/Uncheck in the
menu.

 

Deleting an event or a task
You can delete an event or task when viewing it on the
Details screen, by selecting Delete… in the C Calendar
Main menu.

Finding an event
The Menu button contains the option Find..., which is used
to find a text string among all the stored events. The text
string to be found can be read or written into the edit field.
You can also decide if your search is to be case sensitive or
not.

Details screen

C Calendar
main menu

Check.../Uncheck..
alternative

Details screen

Attachment icon

Alarm icon
Day of the event
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If events are found containing the text string, they will be
displayed on the screen.

Settings…
By pressing the Menu button and choosing Settings…, the
list of settings in C Calendar is opened.

 

The setting options are:

• Show empty hours
Determines whether free hours, i.e. no event is booked,
should be displayed in the Day view.

• Day starts
Defines at what time the default day starts, which effects
the different views. The default day will be shown from
the starting time unless there are events entered before
that time.

• Day ends
Defines at what time the default day ends, this has simi-
lar effect to the setting Day starts, see above.

Settings...
Options in

Find dialog box

Text string
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• Default alarm
Enables/disables default alarm for all new events.

• Time before start
Functions together with the Default alarm setting to
enable an audio alarm for events at a specified time be-
fore the starting time.

• Use large fonts
Enables the use of large fonts whenever this is possible
in C Calendar.

Exit C Calendar
Exit C Calendar by selecting Exit in the C Calendar Main
menu, or by pressing ESC a few times in order to go to the
C-Pen main screen.
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C Dictionary

Introduction
C Dictionary is a software application that allows you to
translate and/or look up definitions of words in less than a
second. Whether you translate or look up definitions de-
pends upon which dictionary you choose to install. With
bilingual dictionaries, you can translate from one language
to another. Some dictionaries are monolingual reference
dictionaries and can only look up definitions of words.

C Dictionary translates or looks up words one word at a
time, the same way you would look up words in a paper
dictionary. You can however, scan in an entire line of text
and then choose which word you wish to look up.

Several kinds of dictionaries are available from a variety of
publishers. The dictionaries available for download are
copyrighted by their respective publisher. See Copyright
Noice for details, p. 123.

Before you start installing the dictionaries, make sure you
have a working connection between C-Pen and your PC.
See Using C-Pen with your PC, p. 107.

Installing a dictionary from the C-Pen CD
Follow the steps below to install a Dictionary.

1. The dictionaries are available in the Start menu/Pro-
grams/C-Pen/Dictionaries. Select the dictionary you
want. Make sure you have your C-Pen CD in your CD-
ROM drive.
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Please note that dictionaries not available on the CD at the
time of going to press will be available on
www.cdictionary.com as soon as they are made available.

2. You can now see the C Dictionary Installer view. Make
sure the dictionaries you want are selected.

3. Start your C-Pen, position C-Pen so that it is aligned
with the PC’s IR port or ensure that the cable is con-
nected, then press Start.

4. The dictionary will now be transferred to your C-Pen.
This can take some time, so please be patient. The num-
ber of dictionaries that can be installed in C-Pen de-
pends on the amount of free memory in your C-Pen, see
Info, p. 97.

Installing a dictionary from the web
1. Download the dictionary you want from our web site

www.cdictionary.com.

2. Click on the file, and an automatic installation
program will start.

3. You can now see the C Dictionary Installer view. Make
sure the dictionaries you want are selected.

4. Start your C-Pen, position C-Pen so that it is aligned
with the PC’s IR port or ensure that the cable is con-
nected, then press Start.

5. The dictionary will now be transferred to your C-Pen.
This can take some time, so please be patient. The num-
ber of dictionaries that can be installed in C-Pen de-
pends on the amount of free memory in your C-Pen.

!
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Access to dictionaries
Dictionaries are protected from unauthorized use by a dic-
tionary license key. For more information about how to ob-
tain the license key, see www.cdictionary.com.

The user is requested to provide the license key to activate
a new dictionary in C-Pen (the DICTIONARIES button in
the C Dictionary application). The Enter License Key dia-
log box contains six number boxes. Enter the numbers one
by one using Nav.

 

If you enter the wrong license key four times in a row, the
dictionary will be removed. To try again, you must
reinstall the dictionary, see Installing... above. Once the
correct license key is entered, the dictionary is ready to use.

Please make sure that you have the license key before
you upgrade your C-Pen or remove a dictionary. To
find your license key, select the info button on the
C Dictionary main screen in your C-Pen.

Removing a dictionary
To remove a dictionary from C-Pen, double-click on the My
C-Pen icon on your PC, select C Dictionary and then the
dictionary you want to delete. Use the Delete command in
the File menu. You have to use your PC to remove a dictio-
nary from C-Pen.

Enter
dictionary key

!
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Please make sure that you have the license key before
you delete a dictionary.

Using C Dictionary
Start C Dictionary by selecting the C Dictionary icon in
the main screen and press Nav.

 

C-Pen is now ready to translate/look up words. If you want
to change dictionaries before you start reading,
see DICTIONARIES button, p. 80.

 

To translate/look up a word, just read the word with C-Pen
as usual. One of the following events will occur:

1. The word is found in the dictionary and the transla-
tion/definition is presented on the screen, see Trans-
lation/definition screen p. 77.

2. No exact match of the word is found in the dictionary,
a list of alternatives is displayed, see Word selection
list, p. 78.

3. Several words are read. The words are shown on a new
screen where you can select the words to be translated/
looked up, see Word selection screen, p. 79.

C-Pen
main screen

C Dictionary
main screen

Word edit box

The language from
which you want to
translate

!
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4. A dialog box appears, telling you that the word
cannot be found in the dictionary.

When you are reading a word, the word (or part of the word)
in front of and/or behind the accurate word might also be
included. If this is the case C Dictionary acts according to
the following rules:

• If two words are read, the longest word is translated.

• If three words are read, the middle word is translated.

• If more than three words are read, the Word selection
screen is displayed, see next page.

Word edit box
The word/s you have read are directed to an edit box where
you can edit them in the usual way.

1. To be able to edit the word/s you have to close the
dialog boxes, lists or screens that might have been
opened after reading.

2. The edit box will already be selected. Press Nav and a
cursor will indicate that you are in edit mode.

3. Press Nav again to open the Edit menu or use C Write
to edit the word.

4. When you have finished editing, select Done in the
Edit menu or press ESC.

5. The edited word will now be looked up in the
dictionary.
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Word references
Some words in the dictionaries contain references to other
words. The references are displayed in bold italic style.

If you press Nav when a word reference is displayed, a
menu appears and you can choose to:

• look up the reference

• cancel the menu

• close the translation/definition containing the
reference

If you choose to look up the reference, the word will be
translated.

Translation/definition screen
The Translation/definition screen displays the translation
of the selected word. If only part of the text will fit on the
display a scroll bar will appear. Turn Nav to scroll the text.

 

The meaning of bold and italic characters is explained in
Info, see Info button p. 80.

To cancel the scanned word/text and go back to the
C Dictionary main screen, press the pen tip briefly against
the surface (for a C-Pen with an automatic trigger) or press
Trigg briefly (for a C-Pen with a manual trigger).

Translation/
Definition
screen
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A new word can be read without closing the screen. Close
the Translation screen by pressing Nav or ESC.

Word selection list
If the word being read does not match any word in the
dictionary, the application will search for similar words
and display alternatives in a Word selection list.

The most probable word is presented at the top of the list
with the others in descending order of probability. A maxi-
mum of ten words will be displayed. Select a word to see
the translation/definition.

The reason why a word cannot be found may be that the
word is misspelled or that the OCR has given an erroneous
result. Another reason can be that the word is inflected (e.g.
chairs instead of chair).

 

A Word selection list will be displayed if more than one
word is found with the same spelling as the word being
read, but with different meanings.

To cancel the word/text scanned and go back to the
C Dictionary main screen, press the pen tip briefly against
the surface (for a C-Pen with an automatic trigger) or press
Trigg briefly (for a C-Pen with a manual trigger).

You can start to read a new word without closing the list.
Close the Word selection list by selecting Cancel or by
pressing the ESC button.

Word selection list
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Word selection screen
If more than three words are read the Word selection screen
appears. Turn Nav to select a word.

The selected word is looked up and the Translation/defi-
nition screen, Word selection list or Can’t find dialog box
will be displayed.

To cancel the scanned word/text and go back to the
C Dictionary main screen, press the pen tip briefly against
the surface (for a C-Pen with an automatic trigger) or press
Trigg briefly (for a C-Pen with a manual trigger).

 

You can start to read a new word without closing the screen.
Close the Word selection screen by pressing ESC or by
selecting the CANCEL button.

Text Language
The Text Language is automatically set to the language
you are translating from; i.e. German is set for the German-
English dictionary. Exiting C Dictionary will restore the
Text Language to the language that was set before enter-
ing C Dictionary.

Word selection
screen
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Dictionaries button
The DICTIONARIES button in C Dictionary’s main screen
is shown below.

 

The DICTIONARIES button gives you access to the list of
dictionaries in your C-Pen. Select the dictionary you want
to use by checking its check box, and then select OK.

If you want to use the same dictionary the next time you
use your C-Pen you do not have to repeat this procedure,
since the dictionary setting is stored when C-Pen is turned
off.

Info button
The INFO button displays information about the currently
selected dictionary, the number of words, the publisher of
the dictionary and copyright information. Your dictionary
license key is also shown here.

Before you upgrade your C-Pen or delete a dictionary,
make sure you have recorded the license key.

Exit C Dictionary
You can exit C Dictionary from the C Dictionary main
screen by selecting EXIT, or press ESC a few times until
you are back in C-Pen main screen.

!

C Dictionary
main screen

Dictionaries button

!
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C Message

Introduction
C Message is an application for sending faxes to a fax
machine, text messages, SMS, to a mobile phone or e-mails
to an e-mail address. Text messages can only be sent in
combination with a mobile phone. C Message consists of
C Fax and C SMS.

Please note that C Fax and C SMS require a mobile
phone equipped with an IR eye and a fax modem. For
more information please refer to our webpage:
www.cpen.com.

You can send complete files from Notes or write a short
message with C Write into C Message and then send it.
The SMS standard limits the messages sent with C SMS to
a length of 160 characters. Fax messages are not limited.

SMS (Short Message Service) is available for mobile
phones using the GSM system. There is limited access to
this service in several parts of the world. Contact your
mobile phone service provider for information on
availability in your area.

Using C Message
There are two ways to send a message, either from C Mes-
sage or from Notes. If you want to send a text which is not
stored in Notes, you can select the C Message icon in the
C-Pen main screen.

!

!
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The C Message main screen is opened and you can now
send a fax or an SMS by selecting C Fax or C SMS.

 

In order to send a text file stored in Notes you have to open
Notes, select the file and in the menu that appears select
Send. A new menu containing the C Message options will
open and you can choose the desired alternative.

C Fax main screen
The C Fax main screen opens when C Fax is selected.

 

The options in the C Fax main screen are:

• Exit
Exits C Fax and returns to C Message main screen.

• New fax…
Opens the Contact list from which you can select to
whom the message is to be sent, see p. 84.

C Message
main screen

C Fax
main screen

C-Pen
main screen
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• Settings
Settings options for C Fax.

• Sent
Successfully sent fax messages are stored in this folder.

• Unsent
Unsent fax messages, due to transmission error or the
user selecting CANCEL, are stored in this folder.

Please note that only the contacts listed with a fax
number will be shown in the Contact list. If the recipient
is not listed, select NEW... and enter the contact informa-
tion in the Message setup screen, see p. 85.

C SMS main screen
The C SMS main screen  opens when C SMS is chosen.

 

The options in the C SMS main screen are:

• Exit
Exits C SMS and returns to C Message main screen.

• New SMS…
Opens the Contact list, see below.

• New SMS-Email…
Opens the Contact list, see below.

!

C SMS
main screen
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• Sent
The folder where successfully sent SMS messages are
stored.

• Unsent
The folder where unsent SMS messages, due to
transmission error or the user selecting CANCEL, are
stored.

Please note that only the contacts listed with a mobile
phone number (for SMS messages) or an e-mail address
(for e-mail) will be shown in the Contact list. If the
recipient is not listed, select NEW… and enter the contact
information in the Message setup screen, see below.

Contact list
The Contact list is opened when you select New fax…,
New SMS… or New SMS-Email….

The contacts listed in your address book, C Address, are
shown and you can select a contact by checking its check-
box. If you want to send a message to a person not listed in
your address book you can select NEW… and read/write
the information directly into the Message setup screen.

 

To add the new contact information to your address book,
click the ADD TO C ADDRESS button at the bottom of the
Message setup screen, see below. If there are no contacts

Contact list

The message
recipient

Stored contacts in
C Address

!
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listed with e-mail/fax/SMS numbers, the Contact list will
not be displayed. Instead the Message setup screen,  see
below, will appear.

Message setup screen
The Message setup screen is opened when you select
either OK or NEW… in the Contact list, see above.

The buttons in the Message setup screen are:

• ADD TO C ADDRESS

Stores the new information as a new contact in your
address book in C Address.

• SEND

Sends the message if the connection to the mobile phone
is OK. A sent message is stored in the Sent folder. If the
connection failed the message is stored in the Unsent
folder.

• CANCEL

Cancels the Message setup screen and returns to the
previous screen. The message is stored in the Unsent
folder.

There are different options depending on whether a fax,
SMS or SMS-e-mail is to be sent.

 
Message setup
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The fax options are:

• To
The name of the recipient.

• Fax number
The recipient’s fax number.

• Subject
Message subject.

• CC
Name/e-mail address of other person/persons you want
to send a copy of the message to.

• From
The name of the sender/user.

• Message
The message to be sent.

 

The C SMS/SMS-Email options are:

• Mobile phone  number
The recipient’s mobile phone number, needed for SMS
messages.

• Email
The recipient’s e-mail address, needed for SMS-Email.

• Email gateway
E-mail gateway, needed for SMS-Email. This is given to
you by your cellular phone operator.

Message set up
screen (SMS-Email)

Message text field

This number is given by
your mobile phone retailer.
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• Message
The message to be sent.

All fields can be edited either by reading text or by writing
text with C Write.

If OK was selected in the Contact list the chosen contact’s
name and number are automatically entered in the Mes-
sage setup screen.

If Send was selected from Notes you will find the contents
of the selected file in the Message text field in the Mes-
sage setup screen.

Settings
There is a Settings menu for the fax page setup and it is
reached from the C Fax main screen.

 

The Settings menu contains the following options:

• Sender info
Information about the sender, such as name and com-
pany. This information will be inserted on all fax pages
once it has been entered. This information is stored in
the C-Pen memory and has to be entered only once.

• Logotype
A list of stored logotypes, from which you can select the
one you want to put on your fax page. See below.

C Fax
Settings menu
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• Footer
A list of stored footer images, from which you can select
the one you want to put on your fax page. See below.

• Resolution
The resolution of the fax page, with the options Normal
(low resolution) and Fine (high resolution).

Please note that transmission of fine resolution fax pages
is more time consuming.

• Cancel
Cancels the Settings menu and returns to the C Fax
main screen.

Download logotypes and footers
If you have logotypes and/or footers you want to add to
your C-Pen fax pages, you can download them from your
PC to your C-Pen.

Establish a connection between your C-Pen and your PC.
Open C-Pen viewer and copy the image files from your PC
and paste them in the C Fax Logos folder in Storage, see
p. 98. You can also drag the file from the PC folder and drop
it onto the C Fax Logos folder in Storage.

 

Please note that the image files must be uncompressed and
in black-and-white BMP format.

C Fax Logos
folder in Storage

!

!
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Settings 
Settings contains the parameters that control C-Pen. Enter
Settings from the Main screen by selecting the Settings
icon. You can also enter text settings from the Text menu,
p. 50 and the Edit menu, p. 33. A list of the available set-
tings appears.

The following settings are available:

• Text Language

• Read Mode

• Text Quality

• C Write Feedback

• Calibration

• System Settings

Text Language, Read Mode and Text Quality are referred
to as text settings. You should set up these settings to
achieve optimal OCR.

To modify a setting:

1. Turn Nav to highlight the setting you want to change.
Press Nav and a check box or menu appears.

2. Turn Nav to highlight the option you want and press
Nav to select the chosen value.

3. Select OK to close the dialog box and save the
changed setting.

4. Exit Settings by selecting Exit at the top of the
Settings menu, or alternatively press ESC.
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Text Language
Select the language of the text you want to read from the
list of languages, by checking the check box. If you only
intend to read numbers, select Numbers Only as the
language.

Read Mode
Read Mode adjusts C-Pen’s reading format. The options are:

• Continuous
A space is inserted between two separate readings with
the C-Pen. Suitable when you read a complete paragraph
which will be used in a document on your PC.

• Separate lines
Each reading starts on a new line.

• Tab
Each reading starts after a tab.

Text Quality
Use this setting to indicate if the printed text is normal or
inverted (negative).

• Normal
Black text on white background.

• Inverted (negative)
White text on black background.

C Write Feedback
Check the check box if you want to enable/disable the
visual feedback facility in C Write.
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Calibration
The Calibration option increases C-Pen’s reading ability
if the text is not black, if the background is not white, or if
the text quality is poor. During the calibration process,
C-Pen will find the appropriate balance of black and white
for the particular surface. If your C-Pen reads poorly, try to
calibrate it. However, the default settings should be able to
cope with most cases.

Calibration overrides the factory settings. The calibrated
setting is not saved when C-Pen is turned off. If you want to
revert to the factory setting without turning C-Pen off,
select Calibration in Settings and then Calibrate. Select
DEFAULT SETTING in the dialog box.

Inverted (negative) text must be reset in Text Quality.

Please note that it is impossible to read red text.

If calibration does not improve the reading accuracy, re-
turn to the default setting.

 

The Calibration menu contains three items:

1. Calibrate, where you can :

Calibrate immediately by moving the pen over the text
surface, see How to... p. 92 and 93, or return to the DEFAULT
SETTING which is the factory setting.

!
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2. Options, where you can enable/disable the Quick
Calibration option.

Quick calibration is the preferred option if you often
read texts with very different text contrasts. Quick
calibration is disabled as default.

Quick calibration enables C-Pen to start a calibration
as soon as you press Trigg.

 

For a C-Pen with a manual trigger, the pen tip should
be pressed flat against the surface and held, perfectly
still, while you press Trigg for about two seconds.

For a C-Pen with an automatic trigger the pen tip
should be pressed flat against the surface and held,
perfectly still, for about two seconds.

3. Cancel, returns to the main menu.

How to Calibrate a C-Pen with a manual trigger
Calibrate adjusts C-Pen’s reading ability according to the
contrast between the text and its background. When the
C-Pen display says “Press scan to calibrate”, follow these
instructions:

1. Hold C-Pen with the pen tip flat against the surface.

2. Press Trigg while moving the pen. If calibration is
performed from a menu other than the Settings main
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menu, you should press Trigg, hold the pen still for
two seconds and then move it over the surface.

3. A progress indicator appears on C-Pen’s screen.

  

4. Move C-Pen over the text, in circles or back and forth.
Continue to move C-Pen until the progress bar is
complete.

5. A message indicates that calibration has been
completed.

When your C-Pen is calibrated the Text Quality icon in
the status field changes appearance.

How to Calibrate a C-Pen with an automatic trigger
When C-Pen instructs you to calibrate, follow these in-
structions:

1. Hold C-Pen with the pen tip flat against the surface. If
calibration is performed from a menu other than the
Settings main menu, you should first hold the pen
still for two seconds and then move it over the surface.

Text Quality icon
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2. A progress indicator appears on C-Pen’s screen.

3. Move C-Pen over the text, in circles or back and forth.
Continue to move C-Pen until the progress bar is
complete.

4. A message indicates that calibration has been
completed:

When your C-Pen is calibrated the Text Quality icon in
the status field changes appearance.

System Settings
To see which of the following settings that are available
with your C-Pen see C-Pen Models, p. 6-7.

• PIN code
You can control access to your C-Pen by a four-digit
PIN code. Enter the PIN code setting to enable or dis-
able your PIN (Personal Identification Number).

When the dialog box opens, the zero in the first position
will blink. Turn Nav to select the first digit of your PIN.
Then press Nav to go the next position. Continue with

Text Quality icon
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all four digits. When you have reached OK,  press Nav
and confirm the PIN in a new dialog box.

 

If a PIN code is enabled, you must enter the PIN each
time C-Pen is turned on. After three unsuccessful attempts,
C-Pen will turn off. You get three attempts each time
you start C-Pen.

Warning! If you start C-Pen by selecting DISABLE PIN

CODE in the start up dialog box, all data in C-Pen will be
lost! You can change or disable your PIN code by selecting
PIN code in System Settings.

Please remember to write down your PIN code and keep
it in a safe place, in case you forget the code!

• Contrast
Display contrast. Select the bar and turn Nav to change
the display contrast.

• Time
The time shown in the status field can be set according
to your preferences.

• Sound
Alarm sound and a System sound which can be switched
on/off. The System sound is activated in combination
with certain message dialog boxes.

!
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• Menu Language
The language that C-Pen uses in its menus and dialog
boxes. Select the desired menu language in the list of
check boxes.

• Font
The font size on C-Pen’s display can be altered between
Large (default) and Small. Depending on the C-Pen
model Large gives a 2-5 row display and Small gives a
4-7 row display.

• Power-off time
The duration of inactivity in minutes before C-Pen turns
off automatically.

• Left/Right Hand
A Left/Right-handed option. Check Left or Right to
orientate the text on the display for left- or right-handed
use. Select OK and press Nav.

• Exchange Trigger/ESC
For a C-Pen with a manual trigger, the option to ex-
change the functions of Trigg and ESC. Checked box
means normal use, see Parts of C-Pen, p. 14.

• Autotrigger
For a C-Pen with an automatic trigger, the Autotrigger is
enabled by default. The Autotrigger can be switched
off and you will then have to press the ESC button in
order to read text. The ESC button will become the
Trigger (Trigg) and there will be no ESC button.
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Info
Info contains a list of help and information topics. Press
Nav or ESC to close the topic. The topics are:

• Exit
Exits Info.

• Getting started
Instructions on how to perform a successful reading.

• Troubleshooting
Solutions to common problems.

• Support
Support addresses to C Technologies.

• About C-Pen
Contains OS (Operating System) version numbers and
serial number. You should have these numbers available
when you contact C Technologies for support.

The amount of free memory space is also given. If the
scroll bar is present, select it and turn Nav to scroll
through the information. To close the topic, deactivate
the scroll bar by pressing Nav or ESC, then select OK or
press ESC.
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Storage 
Storage is a storage area for computer files, that can be
used as a floppy disk. Storage contains the folder C Fax
Logos, see p. 88, which is used when sending fax mes-
sages, see C Message.

Selecting a file in Storage opens a menu with the follow-
ing menu items:

• Open
Opens the selected file.

• Delete
Removes the selected file.

• Properties
Displays the selected file size, creation date and date of
last modification.

• Beam
Transfers the selected file by IR, see p. 100.

• Cancel
Cancels the menu.

To be able to use Storage, C-Pen must be connected to a
PC and C Win Software must be installed. See Using C-Pen
with your PC, p. 107.

To start Storage, you must connect your C-Pen to your PC
by double-clicking the My C-Pen icon on your PC. Stor-
age is started by double-clicking the Storage icon in
C-Pen Viewer on your PC. Files which can be edited in C-
Pen Edit (e.g. filename.txt) are opened by double-clicking
the files. Other file types can be opened in two ways.
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Copy the file to a temporary folder on your PC and then
open it with its default Windows application.

Double-click the file and you will be asked if you want to
open a copy instead. Choose to open a copy.

In these cases, if you edit the file and save it, your changes
will be saved on your PC, not in your C-Pen.

Files are copied as usual in Windows, i.e. either by using
drag-and-drop or Copy/Paste in the Edit menu. See Copy
and Paste in the PC environment, p. 110.

You can delete files in Storage by selecting the file/files
you wish to delete and then pressing the Delete button on
your keyboard. The Delete command is also available in
the File menu. Please note that this operation cannot be
undone.
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C Beam
C Beam is used to transfer notes, contacts, calendar events
and other files between C-Pen and PDAs (Personal Digital
Assistant). C Beam supports the standard infrared protocol
IrOBEX and complies with both the vCard and vCalendar
standards.

Please note that the PDA device must support the standard
infrared protocol IrOBEX in order to be used with C-Pen.

If you should experience problems with C Beam, start by
turning off and on both C-Pen and the PDA device.

Receiving files
In order to receive information files from a PDA device with
your C-Pen, follow the steps below.

1. Make sure that the C-Pen’s IR-eye is directed towards the
PDA device’s IR-eye.

Please note that it is very important that the IR-eyes are
aligned and in range of each other (5-20 centimeters, or 2-8
inches). There must be no obstacles between the devices.

2. Send the file from the PDA device according to the in-
structions in the  PDA’s user manual.

3. The IR-symbol in C-Pen’s status field indicates activity.
The Receive dialog box appears on the screen, display-
ing the name of the transferred file.

4. You can cancel the transmission at any time by pressing
CANCEL in the Receive dialog box.

!

!
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5. After transmission the Accept dialog box is displayed,
asking if you want to accept the transferred file.

6. If you press YES the file will be saved in the appropriate
place,  i.e. a text file is saved in Notes, a contact file is
saved in C Address, a calendar event is saved in C Cal-
endar and so on. Files not compatible with any of the
C-Pen applications are saved in Storage.

If you press NO, C-Pen will discard the received file and
no further action will be taken. You must repeat the trans-
mission if you press NO by mistake.

Please note that in order to receive several files you must
answer either YES or NO in the Accept dialog box after
every transferred file.

Send files
To send information files from your C-Pen to a PDA device,
follow the steps below.

1. Make sure that the C-Pen’s IR-eye is directed towards the
PDA device’s IR-eye.

Please note that it is very important that the IR-eyes are
aligned and in range of each other (5-20 centimeters, or 2-8
inches). There must be no obstacles between the devices.

2. Choose the file you want to send. You have the
following alternatives:

Send a text file. Enter Notes and select the file you
want to send, then select Beam in the menu that
appears.

!
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Send a contact. Enter C Address and select the file
you want to send, then select Beam in the menu that
appears.
Send a calendar event. Enter C Calendar and select
the file you want to send, then select Beam in the
menu that appears.
Send other files, saved in Storage. Enter Storage and
select the file you want to send, then select Beam in
the   menu that appears.

Please note that only files can be sent, not folders.

3. C-Pen starts searching for the PDA device in order to
send the file and the Searching dialog box appears on
the screen.

 

4. During transmission, the file name is displayed in a
dialog box together with a progress bar.

5. You can cancel the transmission at any time by pressing
CANCEL.

6. When the transmission is complete a dialog box will
appear, telling you whether the transmission was suc-
cessful, or not.

Select Beam
 in the menu

!

Searching
dialog box
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C Direct
C Direct gives you the opportunity to enter text from your
C-Pen at the cursor position in any Windows program. To
be able to use C Direct, C Win Software has to be installed
on your PC. See Using C-Pen with your PC, p. 107.

The easiest way to control C Direct is from the C Direct
icon in the system tray in Windows. By clicking on the
icon, you can choose Connect, Disconnect or Exit C Di-
rect. To activate C Direct you can simply double-click on
the icon. For more information about how to use C Direct,
please click  your PC’s Start button/Programs/C-Pen/C-Pen
Help.

Using IR
To activate C Direct place C-Pen in front of the IR port on
your PC. Click the Start button/Programs/C-Pen/C Direct
or click on the C Direct shortcut on your desktop.

The C Direct icon will appear in the system tray in the
lower right-hand corner of your PC screen. The icon will be
partly yellow when C Direct is connected, otherwise the
icon is greyish.

The display on your C-Pen will show “C Direct”.

 

the C Direct icon in the system tray
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When you read text with C-Pen, it will appear as usual on
C-Pen’s display. To transfer the text to the Windows pro-
gram, direct C-Pen’s IR-eye towards the PC’s IR port. The
text will disappear from C-Pen’s display and be transferred
to the cursor position in the Windows program.

Using cable
To activate C Direct make sure C-Pen is connected to your
PC with the cable. Click the Start button/Programs/C-Pen/
C Direct or click on the C Direct shortcut on your desktop.

The C Direct icon will appear in the system tray in the
lower right corner of your screen. The icon will be partly
yellow when C Direct is connected, otherwise the icon is
greyish.

The display on your C-Pen will show “C Direct”.

 

When you read text with C-Pen, the text will be transferred
immediately to the cursor position in the Windows pro-
gram. The text will not be visible in C-Pen’s display.

the C Direct icon in the system tray
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C Write
C Write is a feature that allows you to draw characters by
using C-Pen as an ordinary pen. C Write makes it possible
to quickly write new texts into your C-Pen but it is also an
important tool during editing.

C-Pen can track its own movement over a surface and
recognize the movement as a letter, digit or symbol. C Write
is an alternative to using the character frame when insert-
ing characters in a text.

The C Write application in the Main menu only gives
information about the function.

For further information on using C Write, see p. 38.
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USING C-PEN WITH YOUR PC
A working connection with a PC is required to install and
remove applications in C-Pen. To enable this communica-
tion certain hardware and software must be installed and
configured properly on your PC.

The following is required for IR communication:

1. An IR port. Laptops often have a built-in IR port. Refer
to your PC’s manual to find out whether your PC is
equipped with an IR port and if so, where it is located.
Most desktop PCs do not have a built-in IR port. In this
case you must use an external IR adapter. Contact your
retailer if you do not have an IR adapter.

2. Infrared drivers are included on the C-Pen CD. It is
crucial to install the infrared driver properly.

3. C-Win Software. This software is installed from the
C-Pen CD.

The following is required for cable communication:

1. Cable. The cable is included in the C-Pen package.

2. COM port (serial port). The cable should be plugged
into an available COM port on your PC.

3. C-Win Software. This software is installed from the
C-Pen CD.

Installing C-Win Software
C-Win Software and the infrared driver – if required – are
installed when you run the installation programs on the
C-Pen CD. The menu option Documentation on the C-Pen
CD contains the User's Guide  and Help. The installation
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program also enables you to view Tutorial videos, which
demonstrate how to use C-Pen for best results. Click the
file you want to read.

To install C-Win Software (C-Win):

1. Put the C-Pen CD into your PC’s CD-ROM drive and the
installation program will start automatically. If installa-
tion does not start, click the Start button/Run and  type
x:\cpen.exe, where x: denotes the CD-ROM drive.

2. To install C-Win, click Software installation.

When C-Win is installed, the installation of C-Win com-
munication settings (IR and/or cable) starts. If you have
a C-Pen with a cable connection, you can choose to com-
municate by IR, cable or both. Please follow the in-
structions.

Infrared drivers might already be installed on your PC.
The installation program will tell you if this is the case.

Infrared hardware on laptops can be configured in many
different ways. Please follow the instructions in the in-
stallation program. If you have questions about IR com-
munication, please click the Start button/Programs/
C-Pen/Troubleshooting or go to www.cpen.com/support
and click on Troubleshooting, or contact your laptop
retailer or manufacturer.

Connecting C-Pen to a PC by IR
To connect C-Pen to your PC, position C-Pen so that it is
aligned with the PC’s IR port as shown in the figure.
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The installation program will place a C-Pen icon (My
C-Pen) on your PC’s desktop. When C-Pen is within range
of the PC’s IR port you can double-click on the icon. If
communication is established between the PC’s IR port
and C-Pen, a communication icon will appear in the status
field on C-Pen’s display. 

On most laptops the built-in IR port - a red or black shiny
plastic square - is found on the back or side of the com-
puter.

Connecting C-Pen to a PC by Cable
To connect a C-Pen to your PC, plug in the cable in C-Pen
and in an available COM port on your PC.
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The installation program will place a C-Pen icon (My
C-Pen) on your PC’s desktop. When C-Pen is connected to
your PC you can double-click on the icon. If the cable
connection between C-Pen and the PC is in order, a com-
munication icon will appear in the status field on C-Pen’s
display. 

Getting Help
To get more detailed help using C-Win, open C-Pen Viewer
(by double-clicking on the  My C-Pen icon), from the Help
menu select the C-Pen Help Topics. Or click your PC’s Start
button/Programs/C-Pen/C-Pen Help. You can also press F1
on the PC keyboard to enter the C-Win Software Help.

C-Pen Viewer
Open C-Pen Viewer by double-clicking on the My C-Pen
icon. C-Pen Viewer enables you to browse the contents of
your C-Pen.



110

 

The user interface looks like Windows Explorer and you
will recognize the applications from the main screen in
C-Pen. Use C-Pen Viewer to open and browse files in your
C-Pen, to create new folders and to remove applications
from your C-Pen.

Your C-Pen Viewer might look different from the figure
above, depending on which options you have enabled in
the Explorer’s View menu.

Copy and paste in the PC environment
In the C-Pen Viewer you can view the details of the pen and
also perform copy and paste operations.

One way of copying and pasting files is to use the Edit
menu at the top of the active window on your desktop.
Select the file you want to copy by clicking on it once.



111

Then click the Edit menu and select Copy in the menu that
appears. Select the folder in which you want to put the
copy. Then click the Edit menu and  select Paste. A copy
of the file is now placed in the selected folder.

Another way is to use “drag and drop”. Click the file you
want to copy and keep the mouse button down. While keep-
ing the mouse button down, move the mouse to point at
the folder where you want to copy the file. Release the
mouse button when the folder becomes highlighted. The
file is now copied to the folder.

Installing and Removing Applications
The applications in your C-Pen can be removed and new
ones can be installed in the C-Pen Viewer. The C-Pen
application’s file name is “.car” (C-Pen Archive). The files
do not have to be placed in any specific folder on your PC,
C-Pen will find them regardless.

To install a new application in C-Pen simply double-click
on the “.car” file you want and installation will begin. You
have to turn C-Pen off and on again to complete the pro-
cess.

To remove an application from C-Pen select the applica-
tion in the C-Pen Viewer and choose Uninstall C-Pen Ap-
plication from the File menu and follow the instructions
on the screen. You have to turn C-Pen off and on again to
complete the process.

Some applications are part of the basic C-Pen functional-
ity and cannot be uninstalled. To see if it is possible to
uninstall an application, select it and open the File menu.
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The application can be uninstalled if the menu option
Uninstall C-Pen Application is enabled.

Transferring Files
There are two ways to transfer files to and from C-Pen. Ei-
ther between a PDA and C-Pen, or between C-Pen and a PC.
It’s practically the same as working with a floppy disk or a
hard drive.

Transferring files to and from a PC
Before transferring files you have to double-click on the
My C-Pen icon on your PC in order to open the C-Pen
Viewer. See C-Pen Viewer, p. 110.

Please note that it is very important that communication
functions properly. The IR-eyes of your PC and C-Pen
must be aligned and in range of each other (5-20 centime-
ters or 2-8 inches). There must be no obstacles between
the devices. If you use the cable, make sure that the cable
is properly connected at both ends.

Find the file you want to transfer (e.g. a text file in Notes)
and select it. Then copy the file and paste it into the
desired folder on your PC. Please read Copy and paste in
the PC environment, on p. 111.

When transferring files from the PC to C-Pen, remember
that each application accepts only its own kind of files.
Notes, for example, may only contain text files and C Ad-
dress accepts only vCard files. Other file types can be saved
in Storage, see Storage, p. 98.

!
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Transferring files to and from a PDA device
Files can be transferred to and from PDA devices if the PDA
device supports the standard infrared protocol IrOBEX. Files
are transferred with the application C Beam, see p. 100.

C Address
C Address, the C-Pen address book, is available in the
C-Pen Viewer on your PC. Double-clicking on C Address
in the C-Pen Viewer presents the address files stored in
C-Pen, listed by their contact name.

The address files are stored as vCard files (filename.vcf)
and can be opened by a vCard viewer such as Netscape
Communicator or Microsoft® Outlook/Microsoft® Out-
look Express on your PC. Double-click on the file and then
click Yes in the dialog box. Please note that this will open
a copy of the file and that your changes will be saved on
your PC, not in C-Pen.

To put an edited address file back into C-Pen, simply drag
it from a folder on your PC and drop it into the C Address
application in the C-Pen Viewer. Note that the dropped file
cannot have the same name as an existing file in C Ad-
dress. If it has the same name as a person already in the
address book, a number is automatically attached at the
end of the added person’s name.

It is possible to synchronize your address files in C Address
with those in Microsoft® Outlook (but not Microsoft®
Outlook Express). Simply click your PC’s Start button/
Programs/C-Pen/C Sync. Selecting C Sync will start an
easy-to-use application which allows you to specify the
extent of synchronization.
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Please note that this application only works if you have
Microsoft® Outlook installed on your computer.

C Direct
C Direct allows you to enter text from your C-Pen directly
at the cursor position in any Windows program.

The C Direct application in the C-Pen main screen only
gives information about the function. C Direct is activated
from the PC and communicates by IR or cable. For further
information on how to use C Direct, see p. 103.

C-Pen Edit
C-Pen Edit is a simple text editor that provides basic text
editing functions, such as cut, copy, paste, find and re-
place. It can communicate directly with your C-Pen to open
and save files, when C-Pen and your PC are connected.

C-Pen Edit lets you edit files stored in C-Pen directly on
your PC, without having to first move them to your PC.
Double-click a text file in Notes in the C-Pen Viewer, and it
will automatically be opened in C-Pen Edit. An opened
file from C-Pen can be saved either to your PC or directly
back into C-Pen. The same applies when you open a file
from your PC. 

Closing the Connection
Close the connection between your C-Pen and your PC by
selecting Disconnect C-Pen from the File menu in the C-Pen
Viewer.

!
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TECHNICAL SPECIFICATIONS
C-Pen 600C
Size: 140 x 35 x 24 mm (5.5 x 1.38 x 1.0 inches)

Weight: 80 g (3 oz) including batteries

Display: 2 or 4 rows

Flash memory: 6 MB

RAM: 4 MB

Battery: 2 x AAA, type LR03

Battery lifetime: 3-4 weeks of normal use

Reading speed: 15 cm/s (6 inches/s)

Character sizes: 5–22 points

C-Pen 800C
Size: 140 x 35 x 20 mm (5.5 x 1.38  x 0.8 inches)

Weight: 85 g (3 oz)

Display: 5 or 7 rows

Flash memory: 8 MB

RAM: 4 MB

Battery: Rechargeable, NiMH

Battery lifetime: 2–3 weeks of normal use

Reading speed: 15 cm/s (6 inches/s)

Character sizes: 5–22 points
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WARRANTY
C Technologies AB warrants that this product is free from defects in

materials and function at the time of original purchase and for a

period of one year from that date. When the name C Technologies is

mentioned in the following text, it means, unless otherwise stated, C

Technologies AB (reg. number 556532-3929), its subsidiaries and

retailers.

If, during the warranty period, any defect in the product arises due to

a deficiency in materials or function, C Technologies pledges to, at C

Technologies’ option, either repair or replace the defective product

with the same or an equivalent model.

C Technologies, however, takes no responsibility for:

1. Damage caused during shipping, by accidents, malicious

damage, modification, incorrect usage, force majeure or any

cause beyond the control of C Technologies, including but not

limited to lightning, water, fire, public disturbances, riots,

strike, war or other similar conflicts.

2. C Technologies is not responsible for damage (including but

not limited to direct or indirect personal injury, lost profits, fall

in production, losses of or alteration to processed information

or any other incidental or consequential damages) caused by

the product or the usage of the product or because the product

cannot be used.

3. Deficient maintenance or a repair performed by unauthorized

persons.

4. Incompatibility due to technological developments.

5. Defects caused by external equipment or abnormal wear.

6. Defects caused by normal wear and tear.
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7. Damage caused by the usage of inappropriate battery.

8. Damage arising in connection with or as a consequence of

upgrading with additions to or alterations of the product, using

software or hardware not produced by or approved by C

Technologies.

If your C-Pen product requires warranty service you should return

the product to the dealer/retailer from whom it was purchased. The

product must be packed in original packaging or with sufficient care

so as to avoid shipping damage. The original purchaser must be able

to show proof and date of purchase with receipt/invoice from point

of purchase in order for this warranty to be valid.

Repair or exchange does not extend or renew the warranty period.

Exchanged defective parts become the property of C Technologies.

When the warranty period has expired, the warranty of exchanged/

replaced parts also ceases.

This product is not to be regarded as having defects in materials or

function if it must be rebuilt in order to be modified in accordance

with national or local technical safety regulations in a country other

than one that the product was meant to be used in.

C Technologies reserves all rights to the product, its hardware, soft-

ware and trademark. Whoever buys or uses the product has no right

to alter, disassemble, reverse engineer or in any other way use any

part of the hardware or software in the product, except in the way

and for the purposes permitted by law.
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LIMITED WORLDWIDE WARRANTY

To the extent such dealer/retailer has joined C Technologies’ world-

wide warranty program, you may, in addition to returning the prod-

uct to the dealer/retailer from which it was purchased, also return the

product to any dealer/retailer in the world carrying such product.

To the extent permissible under law, the warranties provided herein

are exhaustive and constitute the sole and only warranties provided

by C Technologies AB.

C TECHNOLOGIES’ LIABILITY IN TORT (INCLUDING NEGLIGENCE) OR ARIS-
ING OUT OF ANY AGREEMENT FOR THE SALE, USE OR SUB-LICENSE OF THE

PRODUCT SHALL BE LIMITED TO THE AMOUNT PAID BY PURCHASER FOR

SUCH PRODUCT. IN NO EVENT, THE COMPANY WILL BE LIABLE UNDER ANY

THEORY OF LIABILITY FOR ANY INDIRECT, INCIDENTAL, SPECIAL, EXEM-
PLARY OR CONSEQUENTIAL DAMAGES OF ANY KIND OR NATURE WHATSO-
EVER, SUFFERED BY THE PURCHASER, OR ANY OTHER PARTY, ANY END-
USER, CUSTOMER, RESELLER, OR ANY DISTRIBUTOR, INCLUDING WITH-
OUT LIMITATION, LOST PROFITS, BUSINESS INTERRUPTIONS, LOSS OF DATA,
OR OTHER ECONOMIC LOSS ARISING OUT OF THE POOR PERFORMANCE OR

NON-PERFORMANCE HEREUNDER OR ANY USE OF OR FAILURE TO BE ABLE

TO USE THE PRODUCT, EVEN IF SUCH PARTY HAS BEEN ADVISED OF THE

POSSIBILITY OF SUCH DAMAGES AND NOTWITHSTANDING THE FAILURE OF

ESSENTIAL PURPOSE OF ANY LIMITED REMEDY.

C TECHNOLOGIES MAKES AND PURCHASER RECEIVES NO WARRANTIES,
OTHER THAN THOSE EXPRESSLY STATED IN THIS DOCUMENT, OR CONDI-
TIONS ON THE PRODUCT, EXPRESSED, IMPLIED, CONTRACTUAL OR STATU-
TORY, AND C TECHNOLOGIES SPECIFICALLY DISCLAIMS ALL OTHER WAR-
RANTIES AND REPRESENTATIONS INCLUDING WITHOUT LIMITATION ANY

IMPLIED WARRANTY OF MERCHANTABILITY, NON-INFRINGEMENT OR FIT-
NESS FOR A PARTICULAR PURPOSE, ANY WARRANTIES ARISING FROM A

COURSE OF DEALING, USAGE OR TRADE PRACTICE AND ANY WARRANTIES

CONCERNING THE NON-INFRINGEMENT OF THIRD PARTY RIGHT.
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Warranty Information

Serial number:

Customer:

Date:

Address:

Dealer:

Address:

CT number:
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DECLARATION OF CONFORMITY
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UL STATEMENT

All UL-labelled C-Pen products fulfill the requirements of
the UL 1950 standard: UL Standard for Safety of Informa-
tion Technology Equipment.

C-Pen models with built-in rechargeable batteries are to be
used with Direct Plug-In Transformer unit marked
“Class 2” rated from 4.05-4.95 Vdc, 450-550 mA.

The built-in rechargeable batteries are not operator
accessible or replaceable.
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C DICTIONARY COPYRIGHT NOTICE
Copyrights for the following dictionaries are held by their
respective publisher. Copyright information for additional
titles from current and/or additional publishers made avail-
able by C Technologies after this publication goes to print
will be listed at www.cdictionary.com.

• Norstedts Ordbok is a trademark of Norstedts Ordbok
HB, Teknologgatan 8c, Stockholm, Sweden

• Norstedts engelska (Engelsk-svensk/Svensk-engelsk)
ordbok
Copyright © 1994 Norstedts Ordbok AB, All rights
reserved

• Norstedts tyska (Tysk-svensk/Svensk-tysk) ordbok
Copyright © 1998 Norstedts Ordbok AB, All rights
reserved

• Norstedts fransk (Fransk-svensk/Svensk-Fransk)
ordbok
Copyright © 1989 Norstedts Ordbok AB, All rights
reserved

• “Oxford University Press” and “Oxford” are registered
trademarks of Oxford University Press, Great
Clarendon Street, Oxford, England

• Concise Oxford Thesaurus © Oxford University Press
1995 –Additional Material © Market House Books
Ltd. 1995
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• Concise Oxford Hachette French Dictionary © Oxford
University Press 1995, 1998
© Hachette Livre 1995, 1998

• Concise Oxford-Duden German Dictionary © Oxford
University Press and Bibliograpisches Institut & F.A.
Brockhaus AG 1991, 1997, 1998

• Concise Oxford Spanish Dictionary © Oxford Univer-
sity Press 1995, 1998

• Oxford Zanichelli Concise Dictionary ©1997
Zanichelli editore S.p.A.

• Concise Oxford Dictionarv 10th edition © Oxford
University Press 1999

• “Merriam-Webster’s”  is a registered trademark of
Merriam-Webster Incorporated, 47 Federal Street,
Springfield, Massachusetts, USA

• Merriam-Webster’s Collegiate® Dictionary Copyright
© 2000 by Merriam-Webster, Incorporated

• Merriam-Webster’s Collegiate® Thesaurus Copyright
© 1988 by Merriam-Webster, Incorporated
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B
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Contact edit screen  52
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Contact menu  54
Delete a contact  57
Edit a contact  56
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Find a contact  56
Find contact screen  56
Options  54

Saving a file  54
Synchronizing address files
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Using C Address  52
vCard files  113
View a contact  55

C Beam  8, 47, 100
Accept dialog  101
Folders  102
Receive dialog  100
Save files  101
Searching dialog  102
Using C Beam  100

C Calendar  9, 46, 58
Alarm  66, 71
Back/Forward button  61
Checked/unchecked task  69
Create event  63
Create task  67
Day button  59, 62
Day view  62
Delete event/task  69
Details screen  68
Event edit screen  64
Event options  65
Event/Task information  68
Exit  71
Find an event  69
Find...  61
Main menu  59
Menu button  59
Month button  59, 63
Month view  63
Repeat button  66
Repeat options  66
Settings  70
Task button  59
Task edit screen  68
Task list  67
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Using C Calendar  58
View buttons  58
Week button  59, 62
Week view  62

C Dictionary  9, 46, 72
Dictionaries button  79
Dictionary licence key  74
Exit C Dictionary  80
Info button  80
Installing a dictionary from

C-Pen CD  72
Installing a dictionary from

the web  73
Remove dictionary  73
Text language  79
Translation screen  77
Word edit box  76
Word references  77
Word selection list  78
Word selection screen  79

C Direct  8, 47, 103, 114
Using cable  104
Using IR  103

C Fax Logos  88
C Message  9, 46, 81

Add to C Address button  85
C Fax Logos  88
C Fax options  86
C SMS main screen  83
C SMS options  86
Contact list  84
Criteria  81
Download logotype/footer

88
Email gateway  86
Email options  86
Footer  88
Logotype  87

Message setup screen  85
Resolution  88
Send  85
Send file stored in Notes  82
Settings  87
SMS-Email options  86
Unsent  83, 84, 85
Using C Message  81

C Read  8, 28, 48
C SMS main screen  83
C SMS options  86
C Write  8, 38, 47, 105

Basic rules  39
C Write Feedback  39
C Write Prototypes  42
Capital letters  40
Symbols  40
Using C Write  39

C Write Prototypes  42
C-Pen

Battery Compartment  17
Camera Opening  17
Reset  23

C-Pen 600C  6
Cable Connector  17

C-Pen 800C  7
Autotrigger  16
Charging connector  17
Reset  17, 24
Temperature  24

C-Pen Edit  114
C-Pen models  5

C-Pen 600C  6
C-Pen 800C  7
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C-Pen Viewer  109
Cable communication

C-Win software  106
Cable  106
COM port  106

Cable Connector  17
Calibration  91

How to...  92, 93
Quick  92

Camera Opening  17
Character set  35
Character size  11
Charging connector  17
Check box  19, 27
Closing the connection  114
Command menu  49
Connecting C-Pen to a PC by

cable  108
Connecting C-Pen to a PC by

IR  107
Contact list  84
Contact menu  54
Contrast  95
Copy and paste on a PC  110

Drag and drop  111
Edit menu  110

Create event  63
Create task  67
Creating a folder  48
Cursor  50

D
Day view  62
Delete event/ task  69
Details screen  68

Check/Uncheck  69

Dialog box  20
Dialog button  20, 26
Dictionaries button  79
Dictionary licence key  74
Display  16
Display object  18
Download dictionary  73
Download footer  88
Download logotype  88

E
Edit field  20, 26
Edit menu  33

Change  38
Cut, Copy and Paste  37
Delete  37
Insert  36
Quit Editing  38
Select  37
Settings  37

Edit mode  33
Editing text  33

C Write  38
Edit menu  33
Edit mode symbol  33
Entering edit mode  33

Email gateway  86
ESC  16
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Event  63
Edit screen  65
Options  65

Event/task info  68
Exchange Trigger/ESC  96

F
Fax options  86
Features  8
File  48

Beam  50, 55, 98
Creating a new file  48
Delete  49
Open  49
Properties  50
Rename  49
Send  50

Find an event  69
Footer  88

G
Getting started  21

Battery  21
Turning C-Pen On and Off

21

H
Help  12

I
Info  47, 97

C-Pen facts  97
Getting started  97
Troubleshooting  97

Infrared drivers  106

Installing
Applications  111
C-Win Software  106

Installing a dictionary from C-
Pen CD  72

Installing a dictionary from the
web  73

Installing C Beam  100
Installing C-Win software  106
Introduction to C-Pen  5
Inverted text  90
IR communication

C-Win software  106
Infrared driver  106
IR port  106

IR port  16, 108
Ir protocol  100

L
Language, setting  90
Left/Right hand  96
Logotype  87

M
Main screen  18
Menu  19, 26

ESC  26
Selecting  25

Menu language  96
Message setup screen  85
Month view  63
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N
Nav  16
Navigation control (Nav)  25
Notes  48

Command menu  49
Create new file or folder  48
Edit / C Write  51
List of text files  48
Text menu  50
Using C Read/Notes  48

O
OCR  10
On/Off button  16, 21
Optimum reading conditions

10

P
PDA  100
Pin code  94
Power off time  96

R
Read mode

Line break  90
Tab  90

Reading conditions  10
Reading text  28

Deleting a line  32
Text screen  31

Remove dictionary  73
Removing applications  111
Reset  17, 24

S
Saving text  32
Selecting  25
Send file in Notes  82
Settings  47, 89

C Write Feedback  39, 90
Calibration  91
Modify a setting  89
Read Mode  90
System settings  94
Text Language  90
Text Quality  90

SMS-Email options  86
Sound  95
Status field  18
Storage  9, 98

Delete file  98
File properties  98
Open file  98
Using Storage  98

Support  12, 97
Synchronizing address files

113
System Settings  94

Contrast  95
Exchange Trigger/ESC  96
Font  96
Left/Right Hand  96
Menu Language  96
PIN code  94
Power off time  96
Sound  95
Time  95
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T
Task  67
Task edit screen  68
Task list  67
Technical Specifications  115

C-Pen 600C  115
C-Pen 800C  115

Temperature  24
Text colors  11
Text, inverted  90
Text Language  90
Text Language icon

18, 22, 23
Text menu  50
Text Quality  90
Text Quality icon

18, 22, 23, 93, 94
Text screen  31
Text settings  89
Time  95
Transferring files  112

Copy and paste  112
To/from your PC  112
To/from your PDA  113

Trigg  16
Troubleshooting  12, 97
Turning C-Pen On and Off  21

U
Using C Address  52
Using C Calendar  58

Using C Dictionary  75
Using C Direct (cable)  104
Using C Direct (IR)  103
Using C Message  81
Using C-Pen with your PC

106
C Address  113
C Direct  114
Cable communication  106
Closing the connection  114
Getting help  109
IR communication  106

Using C-Write  38
Using Notes/C Read  48
Using Storage  98

V
View buttons  58

W
Week view  62
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